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Both of my kids, Ryan and Lexi, are in Cub Scouts.
They thoroughly enjoy their Cub Scout experience.
Just last weekend, they both competed in their
second Pinewood Derby race.

Their first time was two years ago. A lot has changed
over the past two years. The COVID pandemic
forced the cancellation of last year’s Pinewood
Derby race. But, they competed the previous year.
Ryan was a Lion Cub Scout, and Lexi, too young to
be an “official Cub Scout,” entered a car in the
sibling category. Ryan won second place in his den
with his Bumblebee car, and Lexi won first place in
the sibling division with her Cruz Ramirez car.

The pandemic was hard on the kids’ original Cub
Scout pack. Through the attrition caused by the
pandemic, their pack was merged with another pack
in town. So this year, Ryan is a Wolf Cub Scout, and
Lexi is old enough to be an official Lion Cub Scout.

Their cars this year didn’t fare as well as they did the
previous time they participated in the Pinewood
Derby. And dad learned a lesson, as well. Get the
cars as close as possible to the five ounce (about
140 grams) weight limit without going over. I tried to
keep it under the five ounce weight limit, just in case
the official scale at the weigh-in was off from my
scale at home (they are both digital scales, so there
shouldn’t be that much variance). I undershot the
weight limit by too large of a margin, which sacrificed
speed.

Of course, there’s a whole “science” to making the
Pinewood Derby cars so they go as fast as possible.
Just search on YouTube, and you’ll find a lot of
videos devoted to just this very topic. Applying slight
bends to the axles, using graphite lubricant on the
axles, raising one wheel ever so slightly so there are
only three wheels in contact with the race track,

placing your weights just so, paying attention to the
center of balance. The list could go on and on and
on.

During this year’s “cut-out-athon” where the kids cut
out their car shapes on temporarily donated band
saws, we were unable to attend. My wife was in
quarantine for a breakthrough COVID infection (that
me and the kids, thankfully, never showed any
symptoms of having). That left me with the prospect
of hand cutting/carving the cars, or buying my own
band saw. I mentioned to my wife about getting the
band saw to cut out the cars, and she said “I can’t
even count how many times you said you wish you
had or needed a band saw, so go ahead and get it.”

Score! This year’s Pinewood Derby netted dad the
band saw he’s needed for so long.

Ryan’s car this year was an homage to Optimus
Prime. While not in the shape of Optimus (that would
be a bit hard to pull off in a Pinewood Derby car and
still be competitive), the paint job was blue with red
flames. Ryan’s car came in fourth (out of four cars)
in two of his heats, and second (out of four cars) in
the other two of his heats. Lexi’s car this year was a
purple monster. It was actually a very slender wedge
shaped car, painted a color-shifting pearlescent
purple paint. Her car came in fourth (out of four cars)
in all four of her heats.

From The Chief Editor's Desk...
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Still, even though they didn’t “win,” they had a good
time and learned a lot about fair competition and
good sportsmanship. I wouldn’t miss it for the world!

Until next month, I bid you peace, happiness,
serenity, prosperity, and good health. Oh … and
Happy Valentine’s Day! Users Don't
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by Meemaw

I go to YouTube occasionally and watch graphics tutorials. A couple of my favorite
posters are Logos by Nick and Davies Media Design. I saw one on Logos by Nick
the other day that looked interesting so I thought I’d recreate it here. This might
be a neat effect for a different artwork piece to give as a gift or something that
might advertise your graphics skills.

You want to start out deciding what photo you want to use, and what text you
need. For this project, I’m going to use a photo I have, but I’m going to use the
lorem ipsum generator in Inkscape.

First, after opening Inkscape, import your image (my brother has the cutest dog!)
I edited this one so the background was a single color.

Make a rectangle the same size as your image. The way to make sure of that is
to select your image, then click Edit > Copy. Create a rectangle - just make sure
the corners are square instead of rounded. Now, click Edit > Paste Size > Paste
Size and your rectangle will change to the same size as your image. I filled mine
with a dark grey.

Now we want our text. If you have text you want to use, that’s fine, and you can
copy and paste it into a text box. I’m going to use a text generator in Inkscape.
Click Extensions > Text > Lorem ipsum. It will make its own text box. While you

have a text box open
you want to change to a
thick font, and make it
bold, at least 10 pixel
size. (I used Bookman
Old Style, but you can
use whatever looks
good to you.) You also
want to “compact” the
text by changing the
settings on the letter
spacing and line
spacing. I used -0.25 on
the letter spacing, and
0.90 on the spacing
between lines, but
depending on which
font you use, it could be
different.

Inkscape Tutorial: Create A Text Portrait Effect

https://www.youtube.com/c/LogosByNick
https://www.youtube.com/channel/UCq79-lfj2w7oRXGRcOP2B7g
https://www.youtube.com/watch?v=Mue1v7GDL6I&ab_channel=LogosByNick
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When you have it the way you want it, hold the Shift key to also select the
rectangle, then select Text > Flow into frame. Deselect the two items, then select
only your text, center it and make it white.

Select your image, and click on “Raise To Top” to make sure it will be above your
text. Holding the Shift key, now select your text - ONLY your text, not the
rectangle under it. Now open the Align and Distribute dialog, and using Last
selected in the “Relative to” dropdown, center your two items horizontally and
vertically.

Now, select Object > Mask > Set. WOW! I think that’s cool!

I’m sure yours will be just as awesome.

Inkscape Tutorial: Create A Text Portrait Effect

https://www.edx.org/course/introduction-linux-linuxfoundationx-lfs101x-0#!
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Help PCLinuxOS Thrive & Survive
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Screenshot ShowcaseScreenshot Showcase

Posted by Alistair Einstein Izzard, January 3, 2022, running KDE.

https://www.patreon.com/pclinuxos
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by Alessandro Ebersol (Agent Smith)

"Three times faster than Chrome. Better privacy
by default than Firefox. Uses 35% less battery on
mobile." This is how Brave Browser presents itself.
But, is it really true?

Brave browser was created as a derivative of
Chromium, the open source version of Google
Chrome Browser. It was released in 2016, and came
with many promises: Privacy, speed, and rewards for
users, BAT's (Basic Attention Tokens), a form of
cryptocurrency, which, according to the browser's
creators, rewards creators and users.

Brave, designed to be a browser that respects
the user's privacy

The Brave browser uses the motto: "You are not a
product". It focuses on improving the privacy and
security of its users. Brave also brings a new
approach to the advertising ecosystem, ensuring
that both advertisers and users benefit from ads by
decreasing the amount of disruptive ad content.
Advertisers are introduced to a more relevant range
of users, while users are offered the opportunity to
convert their advertising experience into a source of
revenue.

However, over time, the mechanics of the Brave
browser have gradually changed in a way that
exposes the personal data of its users, and
ultimately betrayed their trust, in Brave's initial motto.

Strange practices began to surface

On February 10, 2019, a Twitter message directed to
Brendan Eich asked what a significant change in
Brave's source code meant:

And the change was

This whitelist variable is associated with code in the
tracking_protection_service.cc file that adds various
Facebook and Twitter hostnames to the whitelist
variable so that they are not blocked by Brave's
Tracking Protection feature.

The list of whitelisted URL's is:

• connect.facebook.net
• connect.facebook.com
• Staticxx.facebook.com
• www.facebook.com
• scontent.xx.fbcdn.net
• pbs.twimg.com
• scontent-sjc2-1.xx.fbcdn.net
• platform.twitter.com

• syndication.twitter.com
• cdn.syndication.twimg.com

The response from the Brave browser team was that
the developer team decided to whitelist Facebook
and Twitter tracking scripts because blocking them
would affect the functionality of many sites. One of
the Facebook features that would be broken
includes Facebook logins.

Now, that was a very convenient response, which
has a basis in truth. However, such trackers, being
left off the hook, can also identify and deliver users'
browsing habits to third parties. And, Facebook
(Meta now) is known to abuse the personal data of
its users.

But, that's not all. With the involvement of the
company Brave Software, Inc. with cryptocurrencies,
other "strange" incidents have happened.

The browser has started showing, on its homepage
or new tab, a new form of monetization for Brave:
sponsored images. Sponsored images were
introduced in 2020, and according to Brave's blog
"These branded images will appear in the form of

Brave Browser: False Privacy?
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large, beautiful background images within our new
tab. The sponsored images will bring in additional
revenue to support Brave's mission and give users a
new reason to turn to Brave Rewards so they can be
compensated for their attention. These images will
begin appearing in our mobile and desktop browsers
in the coming months."
However, there was no opt-out setting for this Etoro
cryptocurrency system, with the user who opted in to
Brave Rewards automatically being taken to the
Etoro affiliate program.

It turns out that it was only thanks to the opening of
a ticket on github about this "problem" that there was
a change to make it an opt-in.

And the ad blocker?

According to Werwolf from the Black Gnu website:
"Their ad blocker is just a fork of uBlock Origin,
which is not necessarily bad, but another reason to
avoid using Brave is that uBlock Origin works best in
Firefox and there is nothing Brave can do about that.

Another side effect of using a browser that is made
by Google is that Google will make decisions that
benefit its advertising business, such as making it
impossible to use ad blockers in any Chrome-based
browser. And, of course, this will affect Brave."

However here, doing a deeper analysis, although
Werwolf's statement is true, at its source, there are
advantages to Brave's integrated ad blocker: "Since
Brave's ad blocker is integrated directly into the
browser (i.e. it's not an extension), the limitations of
Manifest V3 don't apply." - according to user wmitty,
from the Hacker News site.

The controversy with Tom Scott

In 2018 there was a serious controversy with British
YouTuber Tom Scott. Popular British YouTuber, Tom
Scott, prides himself on not asking for donations or
crowdfunding on any platform.

However, in 2018, he discovered that Brave browser
was using his name and image to collect donations
on his behalf. Since Scott had not requested or
consented to this, he asked Brave to stop, and to
refund any donations made. Brave replied that "we
will see what we can do," but that "refunds are
impossible."

Of course, refunds should really be impossible,
given the alleged anonymous nature of Brave's tips.
But asking for donations "for" someone, without their
consent, is highly questionable, if not downright
fraudulent. It really doesn't help that the pop-ups,
which appear on Scott's YouTube channel and
personal website, are so deceptively designed.

Conclusions: To use or not to use Brave?

Well, with several arguments against Brave, and
further checking the technical nature of several
problems, I still think Brave is better than Google
Chrome.

It consumes less memory, is faster, does not load
the system as much, and with some adjustments, it
can become better than it already is.

And how to do that?

Let's see.

Tweaking Brave to decrease sending data to
third parties

The first thing to do is to disable the automatic
sending of data to Brave, Inc.

How? Do this: Go to Settings -> Advanced
settings -> Privacy and security -> Automatically
send totally private product reviews to Brave. Set
it to disabled.

Also, in the same section, disable “Send usage
statistics to improve Brave browser”.

Now to block those strange URLs we can do one
thing: Edit the hosts file in /etc.

The hosts file intercepts known addresses and
translates them into IPs, without the need to consult
a DNS server. It already has one address registered,
which is the ip of localhost (127.0.0.1).

So we can add the following addresses to the list:

127.0.0.1 static.brave.com
127.0.0.1 crlsets.brave.com
127.0.0.1 brave-core-ext.s3.brave.com
127.0.0.1 safebrowsing.brave.com
127.0.0.1 static1.brave.com
127.0.0.1 laptop-updates.brave.com

Brave Browser: False Privacy?

http://www.linuxforums.org/forum/
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127.0.0.1 variations.brave.com
127.0.0.1 grant.rewards.brave.com
127.0.0.1 api.rewards.brave.com
127.0.0.1 rewards.brave.com
127.0.0.1 p3a.brave.com
127.0.0.1 go-updater.brave.com
127.0.0.1 componentupdater.brave.com

Of course it must be done with a pure text editor,
and as root. After adding the addresses, save the
hosts file and Brave will never phone home again.

I hope you enjoyed this review of the Brave browser,
and don't be scared of Brave browser stories. It is a
pretty good browser, and with a little tweaking it gets
even better.

Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Help PCLinuxOS Thrive & Survive

DONATE
TODAY

Posted by mutse, January 5, 2022, running Mate.

Brave Browser: False Privacy?

http://www.pclinuxos.com/?page_id=10
https://www.patreon.com/pclinuxos
http://www.commandlinefu.com
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Serves 8

Ingredients:

1 lb. lean ground beef
1 (26 to 28-oz.) jar tomato pasta sauce
1 (8-oz.) can no-salt-added tomato sauce
1/2 (9-oz.) pkg. (about 8) no-boil lasagna noodles
1 (1-lb.) jar Alfredo pasta sauce
12 oz. (3 cups) shredded mozzarella cheese
1/4 cup grated Parmesan cheese

Directions:

Brown ground beef in a large skillet over medium-
high heat until thoroughly cooked, stirring frequently.
Drain.

Spray 4 to 5-quart slow cooker with nonstick cooking
spray. Spread 3/4 cup of the tomato pasta sauce in
the bottom of the sprayed slow cooker. Stir
remaining tomato pasta sauce and tomato sauce
into ground beef (center, top).

Layer 3 lasagna noodles over sauce in a slow
cooker, breaking noodles as necessary. Top with 1/3
of the Alfredo pasta sauce, spreading evenly.

Sprinkle 1 cup of the mozzarella cheese. Top with
1/3 of the ground beef mixture, spreading evenly
(right, top).

Repeat layering twice, using 2 lasagna noodles in
the last layer. Sprinkle Parmesan cheese over top.

Cover; cook on Low setting for 3 1/2 to 4 1/2 hours.
If desired, cut into wedges to serve.

Nutrition:

Calories: 388 Carbs: 43g Fiber: 4g
Sodium: 1119mg Protein: 27g

PCLinuxOS Recipe Corner

Easy Slow-Cooker Lasagna

http://www.dosgamesarchive.com/
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by Paul Arnote (parnote)

Assault On Your Privacy: Monthly Update

Kaspersky has discovered a new MALWARE THAT
CAN SURVIVE EVEN A REINSTALLATION OF
THE OPERATING SYSTEM. According to an article
on PCMag, the Windows-based malware installs
itself to the UEFI firmware on the computer, isolating
it, even in the event of a reinstallation of the
operating system. Called MoonBounce, it was
designed to retrieve additional malware payloads to
be installed on the victim's computer. Hmmm … and
we were told when we were all forced to switch from
the old BIOS system to UEFI that it was more
secure. Oooops!

In early January, Google rolled out another
SECURITY UPDATE TO PATCH ANOTHER 37
SECURITY VULNERABILITIES IN GOOGLE
CHROME. According to a Google blog report, only
one security vulnerability was classified as critical,
with 10 classified as high threat, 10 classified as a
medium level threat, and at least three classified as
a low level threat. You can read about the security

vulnerabilities at the previously linked blog report
above. The “Use After Free” (UAF) exploits are
maintaining their “favored use” status as hackers’
favorite attack vector. If you are a Google Chrome
user and have not updated your browser in a while,
you might want to take a moment to do so.

RESEARCHERS AT INTEZER DISCOVERED A
NEW CROSS-PLATFORM BACKDOOR
MALWARE that attacks Windows, Linux and MacOS
computers alike. While the methods differ slightly
between the platforms, the end result is the same,
according to an article on BleepingComputer. The
malware, named SysJoker, remains largely
undetected by antivirus software. Once installed on
its host computer, the backdoor malware can then
download additional malware, execute commands
on the device, or command the backdoor to remove
itself from the device. The last two instructions have
yet to be implemented, though. On an infected Linux
computer, the files and directories are created under
"/.Library/” while persistence is established by
creating the following cron job: @reboot
(/.Library/SystemServices/updateSystem).

We have a new champion on the block, but I doubt
you’ll see Google crowing about this distinction. IN
2021, GOOGLE DRIVE TOOK OVER THE TOP
SPOT FOR MALICIOUS DOWNLOADS OF
MALWARE FROM MICROSOFT’S ONE DRIVE,
according to an article on TechRepublic. So,
exercise caution when downloading files from
Google Drive, and only download files from those
you trust (if you really even trust anyone, anyhow).

Mapping How Facebook Tracks You

Facebook tracks people. Facebook tracks
EVERYONE. Even non-users. As it tracks you
across the web, it vacuums up as much of your
private personal data as it can, as fast as it can.
Facebook … er, “Meta” … tracks your and my
movement across the web by embedding small,
invisible, 1x1 tracking pixels on web pages. When
those pixels are loaded on a web page, they vacuum
up all kinds of data that you probably don’t want
shared, and that you have no idea may even be
available.

Well, a group of journalists from The Markup have
teamed up with Mozilla researchers to try to map
Facebook’s pixel-based tracking network. They want
to try to gain an understanding of just what of your
private personal data is being collected. The
journalists from The Markup will use the anonymized

Connect connections in one
convenient location!

All your
PCLinuxOS

Short Topix: Mapping How Facebook Tracks You

http://pclosmag.com/links.html
https://www.pcmag.com/news/malware-that-can-survive-os-reinstalls-strikes-again-likely-for-cyberespionage
https://chromereleases.googleblog.com/2022/01/stable-channel-update-for-desktop.html
https://www.bleepingcomputer.com/news/security/new-sysjoker-backdoor-targets-windows-macos-and-linux/
https://www.techrepublic.com/article/google-drive-accounted-for-the-most-malware-downloads-from-cloud-storage-sites-in-2021/
https://themarkup.org/about
https://rally.mozilla.org/current-studies/facebook-pixel-hunt/index.html


PCLinuxOS Magazine Page 13

data for an investigative report about the kinds of
information Facebook, and where it collects it all
from. The “study” runs until July 13, 2022.

Facebook’s “privacy policy” (there’s an oxymoron)
states that Facebook may collect information about
you as you travel across the web, even if you don’t
have a Facebook account. Now exactly how that’s
legal is beyond me, since non-users (hello! … I’m
over here!) never agreed to Facebook’s “privacy
policy” or data collection mechanisms.

According to the web site, this study will collect:

• The data sent to Facebook pixels as you browse

• The URLs of the web pages you browse

• The time you spend browsing pages

• The presence of Facebook login cookies in your
browser

• A study survey that the user completes

• Metadata on the URLs your visit:

• The full URL of each webpage that you are on

• Time spent browsing and playing media on each
webpage

• How far down the webpage you scrolled

Additionally, your participation in the project will
guarantee you the following protections:

• This study will not share granular measurements
data with third parties.

• All efforts to aggregate and analyze the data will be
done in Mozilla’s secure analysis environment.
After completion of analysis we will delete all raw
data.

• All reporting by The Markup will only use
aggregated, anonymized data.

Anyone in the U.S. 19 years old or older can join the
study. Simply follow this link, read through the page,
and click the “Launch Mozilla Rally” button at the
bottom of the page. Who knows. Maybe the
information that is uncovered could lead to laws and
regulations to better protect your private personal
data. Wouldn’t you feel good to know that you
played a role in helping that come about?

Sorry Windows Users. This One Is For Linux
Users ONLY.

Thanks to Intel, Linux users will soon experience
BIOS/UEFI updates in the background … without
requiring a reboot, according to an article on the
HotHardware website. Traditionally, BIOS and UEFI
firmware could be updated, but required a reboot for
the update to take effect. This can be problematic for
servers, which are expected to be up and running
100% of the time … or as close to 100% as you can
get. Couple in the fact that Linux runs the vast
majority of the servers, and you have a huge issue.

Intel has been working on a new ACPI specification
called Platform Firmware Runtime Update and
Telemetry (PFRUT) for a while now. The upcoming
“pfr_update” driver is scheduled to make its debut in

the Linux kernel 5.17. Once that happens, systems
administrators will be able to patch their hardware
without the downtime that was formerly required.

It’s still not clear if this will be a server-only feature,
or if this will find its way into desktop configurations.
Keeping in mind the open source nature of Linux, it’s
quite likely that desktop Linux users could also reap
the benefits of PFRUT. And, since PFRUT is a part
of the ACPI specification, Windows users may also
… eventually… see it implemented.

Wine 7: Even Better At Running Windows
Programs

There are multiple ways to run Windows programs.
You could just dual boot with a version of Windows,
with Windows on its own disk partition, and your
copy of PCLinuxOS on another. But that’s a major
hassle. You can’t just switch back and forth between
Windows and PCLinuxOS. You have to reboot into

Short Topix: Mapping How Facebook Tracks You

https://rally.mozilla.org/current-studies/facebook-pixel-hunt/index.html
https://hothardware.com/news/intel-is-bringing-a-feature-upgrade-to-linux-that-will-make-windows-users-jealous
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one or the other. Plus, it’s fairly wasteful when it
comes to disk space. You could just run a copy of
Windows in VirtualBox (or other virtual machine
program). That’s a little better, since you never really
have to leave PCLinuxOS to run your copy of
Windows. But, this can be quite resource intensive,
consuming a lot of CPU and RAM cycles. Or, you
can run Wine, an open source Windows emulator,
which allows you to run Windows programs directly
on your PCLinuxOS desktop.

On January 18, Wine 7 was released. With the
release of the program that allows running Windows
programs on Linux computers, comes several
improvements. One of the most notable
improvements comes in the notably improved 64-bit
support.

Other improvements include:

• Most modules converted to Portable Executable
(PE) format.

• New light theme.

•WoW64 (Windows on Windows) architecture
implemented.

• Better graphics support.

• Improved Direct3D support.

• Support for multiple displays.

• Improved D3DX support.

• Improved audio support.

• Improved joystick support.

• Better support for Mono/.NET.

• Improved builtin registry tool.

If you’re like most Linux users, you arrived at Linux
after wallowing in the Windows mud pit for a while.
As a result, you may have some Windows programs
that you became fond of. So, if you have a copy of
WordPerfect 7.0 that you just can’t part with, you
should be able to run it on Linux … via Wine.
Typically, Wine is the least resource-intensive way to
run Windows programs, compared to either dual
booting or running Windows in a virtual machine.

Want to know if any of your Windows programs run
on Wine? Never fear, because WineHQ has a
database of over 15,700 Windows programs (often,
multiple versions of each), with reports on how it
runs under Wine. Oddly, some Windows versions of
programs are listed that also have Linux versions,
such as 0 A.D. and AbiWord. I’m not sure why
anyone would run a Windows version of a program
that has an equal version in Linux. It would make
much more sense to just run the Linux version.

Humble Bundle Dropping Linux, MacOS Support

Since its launch in 2010, Humble Bundle has been a
popular source for games on Linux, MacOS and
Windows. The concept was pretty simple. Users
could pay what they wanted and download the
games to their computers. There were also different
levels for monthly subscription plans.

Well, starting February 1, 2022, Humble Bundle is
dropping support for Linux and MacOS. Starting
then and going forward, the Humble launcher will
ONLY work for Windows titles. Apparently, the folks
at Humble Bundle “listened to their users” and
simplified the subscription levels to just one level,
and are dropping Linux and MacOS.

It should come as no surprise that Windows users’
voices would drown out the voices of Linux and

MacOS users. They do make up a considerable part
of the gaming market. But that isn’t the whole story.
Over Humble Bundle’s history, Linux users paid, on
a pretty steady average, twice the amount of money
for the Humble Bundle packages (remember, pay
what you want for the games) as Windows users.

Obviously, in dropping support for Linux and MacOS
users, Humble Bundle is okay with leaving money
on the table, so to speak. Maybe that money will be
enough to attract another, new player in the gaming
supply world to court Linux and MacOS users. That
forthcoming void is still just that, at this point: a void.
Hopefully, it’s a void that is filled quickly for Linux
gamers.

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!
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http://www.dosgamesarchive.com/
https://www.winehq.org/announce/7.0
https://appdb.winehq.org/objectManager.php?sClass=application&sTitle=Browse%20Applications&sOrderBy=appName&bAscending=true
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I’m going to try a more brief approach to these this
month, just so I can fit more of them in here.

One Linux kernel developer, Ingo Molnar, is trying
to clean up the kernel’s “dependency hell,”
according to an article on ZDNet. After 30+ years of
development, the Linux kernel has collected its fair
share of excess baggage. That’s going to mean
2,200 commits to clean up the 10,000 or so header
(*.h) files used when compiling the kernel. The
cross-dependencies between them all are
(in)affectionately known as “dependency hell.”

Y’all know the difference between RAM and storage,
right? I would certainly hope so, if you’ve gotten this
far in your computing life. Well, according to an
article on PCWorld, a recent breakthrough could
see RAM and storage merged into a single unit
that they are calling UltraRAM.

The new Google Chrome 97 should be out, and it
sports some new features for hackers to exploit,
according to an article on LifeHacker. Under the

“Privacy and Security” settings, you can set for
Google Chrome to erase all information stored by
websites you visit (but I’m sure not before all of that
information is sent home to Google). Web
developers will also be able to check to see if your
display supports HDR video. Also, web apps can
now use a previously verboten piece of real estate:
the top app bar. So now, the web apps actually look
like they belong in Chrome.

Samsung’s new Eco Remote, besides being
charged by solar cells, can now recharge itself by
harnessing the RF waves of your wifi signal,
according to an article on The Verge.

Even though Omicron is the dominant COVID-19
strain circulating around the globe, with declining
numbers, you might not want to let your guard down
just yet. There just may be yet another variant just
around the corner. Researchers in France have
identified a new strain, according to an article on
the Firstpost website. Officially named B.1.640.2, the
new variant has been dubbed the IHU strain,
because of where it was discovered. At the time of
the article’s writing, only about 12 people had been
infected with the new variant. The WHO has not
labeled the new variant a “variant of concern” yet.

With NetworkManager working so well for so many
Linux users, the Linux ifcfg tool that has helped
manage network connections for all of these years
may have become unnecessary and superfluous.
According to an article at Phoronix, Fedora 36 is
doing away with ifcfg, and has made a proposal for
its elimination altogether. The 130,000 lines of code
that comprise ifcfg have been frequent sources of
bugs, and consumes valuable system resources. By
eliminating the code, you eliminate the bugs and
gain back the use of the system resources it
consumed.

I bet you thought (like I did) that tape drives were all
but dead. But Japanese tape drive vendor Unitex
has released a new tape drive – with a USB
connection (USB A 3.0, to be specific) – that will

backup 18TB of data in less time than it takes to
back the same amount of data to the cloud,
according to an article on TechRadar. The 18TB
tapes cost about half of 18TB hard drives. But, the
tape drive itself – the hardware part – is expected to
command a price in excess of $6,000. Backing up
18TB of data over a USB 3.0 connection can be
expected to take around 17 hours. But backing up
18TB of data over a broadband connection will take
far, far longer, depending on the throughput speed of
the broadband connection. Users could always
“rent” the expensive tape drive for a day to perform
updates, which might help mitigate the high cost of
the new tape drive.

Users of a Chromium-based browser (Chromium,
Edge, Brave, Chrome, Opera, Vivaldi), will soon
lose the ability to remove search engines from
the default list of available search engines,
according to an article on PCMag.
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by kalwisti

Background

As a New Year's resolution, I am taking baby steps
to learn KDE Plasma 5.23.5, after installing Tex’s
Darkstar minimal ISO (2021.11) on our trusty Dell
Latitude E4300 laptop. I also decided to use this
chance to reacquaint myself with Skrooge, the KDE-
based personal finance program.

I previously used Skrooge (ver. 0.6.0) as a stopgap
in 2010, while KMyMoney became a bit stagnant as
its developers ported the KDE 3 version of KMM to
KDE 4. Skrooge served me well but I stopped using
it when I moved away from KDE. Enough time has
elapsed that I have forgotten many of the program’s
finer points.

The current version of Skrooge is 2.26.1. Skrooge
was launched in March 2008, so it has been actively
developed for 13 years. Its main developer is
Stéphane Mankowski, a French engineer /
programmer who works as a manager at Airbus, the
multinational aerospace corporation. Mankowski is
assisted by Guillaume de Bure, a programmer and
engineer who is also an Airbus employee.

Skrooge's unusual name was inspired by Ebenezer
Scrooge, the protagonist of Dickens' A Christmas
Carol (1843). Some people might also catch the
reference to Scrooge McDuck, the cartoon character
created in 1947 for The Walt Disney Company.1

Ebenezer Scrooge, of course, needs no introduction
in the English-speaking world, as the tale of his
redemption by three spirits has become one of our
most beloved Christmas stories. For non-comics
readers, Scrooge McDuck (who happens to be
Donald Duck's uncle) is famous for his extreme

thriftiness; he is reputed to own three cubic acres of
cash which is stored in a skyscraper-sized Money
Bin.

Skrooge uses single-entry accounting (like
HomeBank or Quicken) rather than double-entry
principles (GnuCash or KMyMoney). The Skrooge
Handbook clarifies that the program is not designed
to manage taxes, nor does it have small-business
functionality.2 However, Skrooge is robust and
perfectly adequate for home / personal accounting.

A complete tutorial is beyond the scope of this
article; if you would like an in-depth presentation of
Skrooge, please consult the "Additional Resources"
section on the last page. Today I will limit myself to
discussing some features not covered in the current
documentation, or which I didn't fully understand
until I began experimenting with them.

User Interface

Probably the first thing that newcomers to Skrooge
will notice is its unorthodox appearance. The use of
docks -- which are a subpart of an application
window -- such as the Page Chooser and the
Messages panel, means that the GUI does not look
like a traditional bank ledger (such as GnuCash).
Although the design is rather "busy," the developers
put careful thought into it; as a result, Skrooge's
interface is very customizable.

In the screenshot below, I have color-coded the UI's
main components. The two docks are the Page
Chooser (outlined in red) and Messages (green).
The Main area is outlined in blue, and the Editing
panel is indicated by an orange rectangle.

Skrooge Revisited: Tips For Beginners
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Data Entry

Despite Skrooge's excellent import capabilities, I
decided the cleanest way to begin was by manually
entering 90 "fresh" transactions from our new bank.
(Our regional bank was acquired by a larger national
bank in mid-October 2021). I am preparing a
continuation of this article which evaluates importing
other file formats – .xhb [HomeBank], .gnucash
[GnuCash], QFX and CSV – into Skrooge, for those
who might be interested in the topic.

Operations Panel Basics

The Operations area and its Editing panel is where
you will do the bulk of your work, viz., entering
transactions into the register. You just need to keep
a few points in mind:

When creating a debit, in the Amount box of the
Editing panel, add an initial minus sign (-) before the
amount, e.g., " -89.75 ":

In the Main area of the checkbook register, debits
appear in parentheses in a red font, e.g., ($23.26);
credits appear in black: $1,244.95:

After adding / entering a transaction, you need to
develop the habit of clicking the Clean editor button.
This will clear the Editing panel and give you blank
fields to enter a new transaction:

Auto-fill is active to save you keystrokes. For
instance, typing "gr" in the Category box will pull up
Food > Groceries.

Mode

When you begin entering data in this field, no
options are listed from the drop-down menu. There
are a few semi-cryptic terms which appear; I am
guessing that they might be internal program
instructions (so I ignored them):

Through trial and error I learned that you can type in
whatever you want. I used standard terms such as
Check, Debit, AutoDep, Credit, Deposit,
Withdrawal, Interest.

After you input the terms, Skrooge will remember
them and offer them as a choice in the drop-down
menu.

Categories

Skrooge includes an assortment of standard
Categories which is very similar to HomeBank's.
Nevertheless, you may modify them to meet your
individual situation (top, right).

To view them, from the Page Chooser, select
Categories:

Skrooge allows an infinite number of Categories
levels, so you can be as granular as you wish with
tracking expenditures.

Add A New Subcategory (The Short Way)

If you need to create a new subcategory, it can be
done easily. In the Category field of the Editing
panel, type in your desired subcategory name,
preceded by a " > ". For example:

• Household > Lawn-Yard

• Other Income > Transfer from Savings

Skrooge Revisited: Tips For Beginners
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Add A New (Sub)category (The Longer Way)

If you wish to create a new primary / main Category:

• From the Page Chooser > select Categories.

• In the Name box, type in < New category name >

• Click on the + button to add it.

Once the category has been created, if you want to
delete it:

• Highlight the Category's name.

• Right-click > then choose Delete.

To add a new subcategory to an already existing
category:

• Select your parent category. In this example,
Business is the parent category.

• In the Name box, type in
<Name of new subcategory>

• Click on the + button.

• The new subcategory will be created:

To delete it, highlight the subcategory's name.
Tick/check the box under the "Closed" column
(identified by a red circle with an "x"):

Next, right click and choose Delete.

Split Transactions

A split transaction – also known as a "split" – is a
transaction that can be assigned to more than one
(expense) category. Some financial apps make
entering split transactions cumbersome; however,
Skrooge handles them capably.

In the Editing panel of the Operations area,

1. Click on the Split button.

This will switch Skrooge into its split operation
editing mode. The fields Category, Comment and
Tracker are replaced by a table. To edit a cell in this
table, double-click on it:

2. Highlight the line entry.

3. Click under the Category column.

4. Enter/choose your desired category:

5. Click on the Amount column.

6. Change the amount as necessary for the
transaction's first expense category:

7. Skrooge will automatically recalculate. In this
example, the app subtracted the amount spent on
groceries [$60.01] from the total transaction amount
[$90.01], leaving a difference of $30.00.

Skrooge Revisited: Tips For Beginners
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8. Click under the Category column for the
remaining amount.

9. Enter/choose your desired category:

10. Click on the Add button:

In the Main area above (i.e., the ledger),
notice there is a "Split" icon/symbol:

Hovering your cursor over it will cause the Split
amounts to display:

Reconciliation

Although The Skrooge Handbook covers
Reconciliation,3 the procedure was a bit abstract for
my comprehension. Browsing the Skrooge forum, I
found a clearer explanation offered by Stéphane
Mankowski, then added some simplified details of
my own.

• Open your Skrooge file.

• Type Ctrl+2 to open the Accounts page / window.

• Select one account you wish to reconcile, by
highlighting it.

Right-click and choose Reconcile to open the
Operations page in Reconciliation mode. (Or, you
may type Alt+R):

Enter the final (ending) balance from your bank
statement in the box.

As you work through the transactions listed in your
statement, click on the corresponding transactions in
Skrooge’s Operations window to mark them as
“Pointed.”

“Pointed” means ‘flagged (for pending
reconciliation)’.

The box next to each amount will turn blue and have
an ellipsis (three dots) in the box.

At the end of the process, the Delta value should be
0.00.

Click on the big check mark to finalize the
reconciliation.

The large check mark has a tooltip that clarifies it will
“Validate pointed operations.”

A pop-up message will appear, stating that “The
account [X] has been reconciled.”

If you chose the option to ‘Hide checked operations’,
the "checked" (i.e., reconciled) transactions will
disappear from the Operations window and become
hidden (next page, top left).

Skrooge Revisited: Tips For Beginners
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Congratulations! You’re done.

If reconciliation is not possible for some reason, you
can create a fake operation that -- in combination
with the other operations you pointed -- sets the
Delta to 0, thus allowing you to complete the
reconciliation process. To accomplish this, click the
"Add" button in the reconciliation mode toolbar.

Search and process Function

Skrooge has a nifty bulk edit feature that allows you
to act on multiple transactions – or payees --
simultaneously. (GnuCash currently lacks this
feature, even though users have requested it several
times). If a payee's name appears with various
permutations – such as Kroger's, Kroger, Kroger's
Grocery – you can standardize the name without
having to manually edit transactions.

In this hypothetical example, there are two variations
of "Hy-Vee" in my Payees list: hyvee and hy-vee. (I
enter my checkbook information in lowercase letters,
to make typing faster and allow me to concentrate
on inputting the numbers correctly).

I would like to clean up that inconsistency; Skrooge
can do it easily:

Open the Payees page (center top).

Click on the misspelled payee (i.e., hyvee):

Drag it and drop it on the correct one (i.e., hy-vee).

All operations with the incorrect "hyvee" payee will
be updated with "hy-vee," and the misspelled
"hyvee" will be removed.

Double-clicking on the hy-vee payee (or, right-
clicking on it > then choosing Open operations) will
show that all the associated transactions have been
fixed:

Configuring the Dashboard

The Dashboard displays an overview of your
accounts and financial situation. You can add
different widgets here, as well as changing the
layout, by clicking on the Configuration icon (right,
top):

For my purposes I found the Accounts (Light) and
Income & Expenditure widgets helpful (as shown at
right):

When you have adjusted the layout to your liking,
keep your changes by going to the View menu >
then choosing Save page state. (As an alternative
you can type Ctrl+Alt+S).

Adjusting the Window Zoom

The Zoom feature allows you to set the font size to
suit your taste:

From left to right, the button functions are: Fit zoom |
Zoom out | Custom zoom (slider bar) | Zoom in.

Skrooge Revisited: Tips For Beginners
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Reports

I would be remiss if I did not mention Skrooge's
ability to generate a variety of impressive reports
and graphs. The best way to familiarize yourself with
reports is to experiment, by choosing different
options and values, and seeing which data
visualization is most suitable for your particular
analysis.

From the Page chooser > select the Report option,
then choose the Data criteria you wish to use for
your report:

• Under Lines, e.g., you have the options of
Category, Payee, Mode (check vs. debit card), etc.

• Under Columns > choose Date, Week, Month,
Quarter, Year, etc.

• Under Mode > choose Sum of operations,
Percent of columns, etc.

Next, decide on the type of graph you want: Pie,
Histogram, Line, Bubble, etc.

As the final step, you select the Dates to be included
in your report. There is a wide range of options
available: Previous (or Current); Month (or Day,
Week, Quarter, Year).

The screenshots at right show some examples of
graphs for Category during the previous month
(December 2021): a pie chart; a histogram; and a
bubble chart.

Monthly Report

Skrooge has another practical feature: the Monthly
report (also accessed from the Page chooser). It
provides "at a glance" summary information for the
time period you choose (Last month, Last quarter,
Last year, etc.). I found it confusing because when

the panel opens, the default Template is called
"tutorial." At first glance, it appeared that some sort
of scripting/coding magic was necessary to run a
personalized report (right, top):

(I should mention that I had already fulfilled the
stated report requirements by creating one account
[checking], adding operations [transactions] and
categorizing the transactions). After further
exploration, I discovered the drop-down menu
associated with Template; among the choices
offered, the default option was most helpful for me
(right):

The screenshots below illustrate the data
summarized in this quarterly report: Personal
Finance Score; Income & Expenditure; Budget (if
already defined); 5 main categories of expenditure; 5
main variations; and Amounts in accounts.

Skrooge Revisited: Tips For Beginners
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Conclusion

If you are already a KDE user and would like to
manage your personal finances with an application
that belongs to the KDE ecosystem, I encourage you
to give Skrooge a try. I enjoy using the program
again; it is full featured and I have confidence in its
accuracy. Skrooge will help count your "three cubic
acres of cash" better than Ebenezer Scrooge, Bob
Cratchit and Scrooge McDuck – combined.

Non-KDE users (Xfce or MATE) should be aware
that installing Skrooge will pull in 55 KDE packages
as dependencies. As a test, I added Skrooge to my
Xfce system; the download was only 38 MB but it
occupies 140 MB of disk space after installation.
(After the installation finished, I logged out of my
user account and rebooted the PC as a safeguard).

Although Skrooge runs fine under Xfce, the icons
and theme – unsurprisingly – look mismatched
compared to their appearance in KDE:

Additional Resources

Alistair George, who is a moderator of the Skrooge
forum, uploaded three video tutorials to Vimeo in
2011. Although the version discussed is old, neither
the user interface nor Skrooge's behavior has
changed drastically. Novices can still benefit by
seeing the program in action:

https://vimeo.com/27796633
"Skrooge Accounting Tutorial #1." 16 Aug. 2011. (17

min., 57 sec.)
Provides an overview of Skrooge's main features,
including data entry / creating transactions in the
Operations panel. It also briefly discusses the use of
templates (for recurring, scheduled payments).

https://vimeo.com/27808880
"Skrooge Tutorial #2." 17 Aug. 2011. (15 min., 31
sec.)
Demonstrates an alternative to using the "wallet" for
cash accounts, via a Split transaction. It also covers
the Tracker field, which provides a means of keeping
records of a designated project's cost.

https://vimeo.com/27893118
"Skrooge Tutorial #3." 19 Aug. 2011. (8 min., 57
sec.)
Demonstrates the Reconciliation process. It also

covers Payees and Categories, showing how to view
a full report of all the transactions (operations)
associated with them.

Meemaw wrote an introduction to Skrooge in The
PCLinuxOS Magazine (2012), as the final article in
her "Linux Financial Apps" series:
https://pclosmag.com/html/Issues/201209/page02.ht
ml

You can ask Skrooge-related questions in the Office
section of the KDE Forum:
https://tinyurl.com/57a6b7zk

Last but not least, The Skrooge Handbook is a
valuable reference source:
https://docs.kde.org/trunk5/en/skrooge/skrooge/inde
x.html

1.
https://userbase.kde.org/Skrooge#What_a_strange_name.
21

2.
https://docs.kde.org/trunk5/en/skrooge/skrooge/index.html
As a historical aside, a brief sketch of Luca Pacioli
(1445-1517), the “inventor” of double-entry accounting,
was featured on NPR's Planet Money podcast. The hosts
interviewed Jane Gleeson-White, who wrote a biography
of Pacioli.

3.
https://docs.kde.org/trunk5/en/skrooge/skrooge/operations
.html#reconciliation

DOWNLOAD

Mate Desktop
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by CgBoy

Xtreme Download Manager is an advanced and
feature-full download manager that’s designed to
accelerate your download speeds by using a
dynamic file segmentation system. It provides
integration for most popular web browsers (Firefox,
Chrome, Opera, Vivaldi, etc) through the installation
of an addon. Xtreme Download Manager also
supports downloading videos from YouTube and
other streaming sites.
Xtreme Download Manager’s interface has a very
modern look, and is fairly easy and straightforward
to use. On the left side are several categories to
help you sort your downloads into their different file
types. From the top-right corner, you can set the
filters to show only complete, incomplete, or all
downloads. From down in the lower-right corner, you
can use a switch to enable and disable the web
browser integration.

To begin downloading a file, just go ahead and click
on the Add URL button down in the lower toolbar.
This will open a small popup window where you can
provide the link for the file you wish to download, as

well as set a location to save the file to. You can also
choose to simply add the download to a queue, if
you wish. If you want to save a video, just hit the
Download Video button in the toolbar. Then you can
provide a link to the video you want to download,
and also set the video resolution options.

Once you start a download, another small window
will popup, displaying the current progress of the
download. To hide this window, click on MORE…
and then click Hide. From the toolbar at the bottom
of the screen, you can pause, resume, and delete
the currently selected download. When downloading
a video, you can also opt to preview the partially
downloaded video file.

Xtreme Download Manager also has a built-in media
converter, which you can use to convert videos that
you have downloaded. Just select a completed
video in the download list, then click on the Media
converter button to open the converting window.
Here, you can choose from a list of video and audio
conversion presets, or manually set your own
parameters. Then, simply choose an output location,
and hit Convert.

Xtreme Download Manager also allows you to
schedule download queues. Simply open the
Downloads menu at the top of the screen, and click
on Queue and scheduler. From this page, you can
manage your download queues, and schedule them
to start and stop at any time and date you choose,
as well as be repeated on certain days, if need be.

Summary

Xtreme Download Manager provided great
download speeds, and in general worked very well
during my use of it. I did, however, encounter some
issues when trying to download YouTube videos,
though this may have just been a problem on my
system. All in all, Xtreme Download Manager is a
great choice for anyone who needs a fast and
powerful download manager.

Repo Review: Xtreme Download Manager

http://www.linuxquestions.org
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compiled by Meemaw

6 Year-Old Made Honorary Ranger

The Make A Wish Foundation is a nonprofit
corporation that helps children with “critical illnesses”
realize a wish. Their mission says, “Wishes are more
than just a nice thing. And they are far more than
gifts, or singular events in time. Wishes impact
everyone involved—wish kids, volunteers, donors,
sponsors, medical professionals and communities.
For wish kids, just the act of making their wish come
true can give them the courage to comply with their
medical treatments. Parents might finally feel like
they can be optimistic. And still others might realize
all they have to offer the world through volunteer
work or philanthropy.”

In November, six-year-old Trinity was able to visit Ft.
Benning, GA’s recruiting battalion in Tampa, FL, and
visit with the Army Rangers. Trinity is battling cancer,
but voiced a desire to see the rangers. While she
was there, they made her an honorary ranger.

Boston Terrier Signals Parents

Jeff & Kelly had taken their 9 month-old daughter to
Urgent Care over the weekend, and intended to take
her to her regular doctor come Monday. During the
night they noticed their dog, Henry, going to their
daughter’s room and head-butting the door open,
even though this was not normal behavior for Henry.

When they checked on their daughter they
discovered that she couldn’t breathe, prompting
them to rush her to the hospital, where they cleared
her airway. She is doing well now.

Jeff is still rewarding Henry! “He was allowed to
sleep in bed with me last night, and he’s got a steak
in his future,” he said.

KFC And Rapper Join Forces

After the devastating tornadoes that swept through
Kentucky in mid-December, Rapper Jack Harlow
and the restaurant Kentucky Fried Chicken joined
forces to donate $250,000 to feed the victims of the
terrible damage.

They donated the $250,000 to the American Red
Cross for the direction of the funds to where they are
most needed. The Western Kentucky Red Cross
also mounted a campaign for further donations.

“At the heart of the partnership is the shared love for
Kentucky, so today, KFC and Harlow are coming
together to support communities across western
Kentucky who were ravaged in the deadly Dec. 11
tornado event,” a spokesperson for KFC and rapper
Harlow announced.

Good Words, Good Deeds, Good News
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Eight Year-Old Boy Saves Veteran’s Burning
Home

Justin was watching a movie at 2:30 a.m. on
January 1st and suddenly noticed flames coming out
of his neighbor’s roof. His neighbor Bob was out of
town at the time, but Justin alerted his parents that
the house was burning, and they called 911.
Firefighters were there quickly and put the fire out
before the house was much more damaged.

The Spring, Texas Emergency Services groups had
a ceremony to honor the eight year-old for his quick
thinking. According to a local news outlet, Justin
received a 911 Kid Hero Award, a Bravery Award, a
proclamation for an act of bravery worthy of
recognition, and children’s firefighter gear.

Community Honors Teen With Birthday Parade

Jocelyn has been like any other teenager, dancing
and cheerleading in her 8th grade class in Ohio. A
few months ago, however, she experienced some
breathing problems, and when the diagnosis was
reached, it was T-Cell Acute Leukemia Lymphoma,
which is a cancer affecting the blood. She’s gone
through chemo ever since.

For her birthday earlier this month, neighbors and
friends got together and had a parade to wish her a
happy birthday.

“I’m just happy I get to see everyone and I just
wasn’t expecting it. I was very surprised,” Jocelyn
told a news outlet.

Trooper Saves Accident Victims

A trooper for the Oklahoma Highway Patrol was
driving the Turner Turnpike when he noticed the
vehicles slowing, and discovered that a semi had
jackknifed and overturned. He ran up to the truck
and found that the occupants were still inside. He
had to climb up on the trailer and make his way to
the truck. Luckily, the door still worked and he was
able to get the two people out of the truck.

A passing driver noticed him on the truck, and
snapped a photo, then shared it on social media. “I
don’t know his name, but THIS is what a hero looks
like to me!!! He came upon this seconds before we
did this…Traffic, including semis, was going crazy in
all directions trying to shut down, but this man was
on a rescue mission to save lives!” the user
continued.

The trooper said he was glad to be in the right place
to help them. “I just tried to clear the road and help
the people,” he added.
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Compiled from The PCLinuxOS Forum

Greetings & Salutations from Denver metro area
by Rick Copple (rlcopple)

Howdy, folk.

Though I currently live in the Denver metro area, I'm
originally from Texas. The longest that I've ever lived
in a city was Marble Falls, TX for 18 years. (Growing
up, we moved a lot!) At any rate, my "computer
history" starts in the mid to late 70s, my Mom had an
old Kaypro computer, with an old "distro" called
"CP/M". Anyone remember that one? I immediately
became interested in it.

My Mom must have noticed, because in the early
80s, she gave me a TI-994a console. It had
cartridges that you could insert to play various
games, mostly. If I'm recalling correctly, it boasted a
4KHz processor, along with a hefty 16K of memory. I
used my TV as the monitor. I learned "Basic"
programming on that computer. One of the first
programs I ever wrote on it was a game: Yahtzee. I
had a general idea of how to do it, and the crazy
thing is, it actually worked! Though it did stress out
the processor to go through the 5-nested loop to
verify that it actually was a long straight, before
awarding the points. Usually it took around 5
minutes -- time enough to get a cup of coffee and go
to the bathroom.

From there I had my first IT experience at a gas
measurement company, working on a Digital RS11
(if I remember that correctly) that had about 6-7
VT100 terminals connected to it. Though, as in most
jobs I've had, that wasn't my only duty, often, not
even my primary one. (I was a bookkeeper from
1996 - 2011, mostly.) That's despite the fact that all

that I know comes from experience, not classes or
any degree (my college degree was in Religion).

Obviously, since I was a bookkeeper during those
years, I was locked away into the Windows systems,
since everyone I worked for used QuickBooks and
that program could only run on Windows (as well as
Macs, but I never used those much). That said, I did
fiddle with Linux during those days. In 2001 or 2, I
"attempted" an install of Debian from a stack of CDs
I had ordered (that was back in the modem days, it
would have taken a couple of days back then, tying
up the phone lines, to even think of downloading 1
Gig, much less the 2-3+ of most ISOs now days). I
failed to get it up and running, however, mainly
because I was looking for starting up the X server,
which I did. However, no graphical menu popped up!
(Shows you how much I knew about Linux). Indeed,
I did get it to boot up into the X environment, but I
couldn't do anything in it. Then, around 2006, I
successfully installed Ubuntu onto my old laptop,
played around with it for a while, but it was only a
passing interest at that time. Around 2011, when my
last client who used QuickBooks ended their

professional relationship with me, I was free to think
more about actually moving to Linux. I discovered
dual-boot, so I did, installing Lubuntu alongside
Windows. It took me around 2-3 months to figure out
how to configure it to my liking, from shortcut keys to
replacement programs. The hardest was a
replacement for inventory as in Quickbooks. I never
did find one, so I created a spreadsheet for it, which
I'm in the middle of updating. That was also the time
I first met Peter Patterson Mint Spider who I know
resides on this forum. {waves} Hi Peter!

At any rate, I've used several different distros since
then, and reviewed several on my YouTube channel
which I started in August of 2018. Then I came
across BDLL, and the community there, and they
have gratefully sucked me into their collective.
Obviously, that is where I met Alie, or Aris. I mixed
those two up as I didn't realize they weren't the
same person until just yesterday. Hi! But if my
memory serves me well (and frequently, it doesn't) I
believe it is Alie. Well, my introduction to PCLinuxOS
was on that channel, where we recently, like 3 or 4
weeks ago, reviewed PCLinuxOS. Which has led me
here, to this community.

I currently have 8 computers (two of them my sons,
and one of them the original computer I first installed
Lubuntu on.) My "daily driver" computer is a fairly
new Framework computer. I've installed PCLinuxOS
BigDaddyTrinity on my son's Lenovo Legion Gaming
Desktop, out in our living room. More about that in
Testimonials.

So, I hope to be able to contribute here some, as
well as learn some more about this distro. Thanks
for inviting me to come here and post my questions,
Peter.

May the Linux force be with you all!

Introduction & Testimonial From rlcopple
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A Trinity BigDaddy PCLinuxOS install gone right!
by Rick Copple (rlcopple)

I just wanted to give some kudos to Alie and
whoever else would be responsible for the Trinity DE
version of PCLinuxOS. I was one of the guys on
BigDaddyLinuxLive, the one who experienced the
most install issues. I did get the TrinityDE BD
PCLInuxOS successfully on my testing distro (a
Lenovo ThinkCenter), with a few "hacks" as the
suggested ones didn't work for me. Basically, I found
the install would go through using the safe boot
option, with the caveat that I would then need to edit
the grub config file to replace two needed
commands for everything to work right, then update
the grub menu to get full working desktop back,
once I had successfully installed the distro. Likewise,
I was also able to install it on a virtual machine on
my Acer Aspire Thin 5, using the same trick.
However, on my brand new Framework laptop, I was
never able to install it in a virtual machine no matter
what I tried, and I tried a lot of things. Hum, makes
me wonder if I should try it again now?

At any rate, my son became disgusted with his
brand new Lenovo Legion Gaming Desktop
computer (LLGD for short from here on out), which
comes with a dedicated Nvidia GPU. He wanted his
gaming laptop back, which I had Garuda installed on
and it appeared to be working fine. So I switched
them out with the intention of working on it later.
Well, "later" arrived for me a couple of days ago.
After messing with it, I determined that the wifi
adapter wasn't working very well on it, so I disabled
it in the system settings of KDE and plugged in an
Ethernet cable. That has appeared to have solved
the problem with the wifi issues he was having,
which was his main gripe about his system,
especially when he was watching videos on it.

But I needed to install a different system on it. I had
Garuda on the 1 T Mvne drive (or whatever those
letters are on that drive) and I had a copy of PoP OS
installed on his 2T SSD drive. I decided to overwrite
the PopOS with something different, especially since

I knew Garuda worked fine on it, I wanted a good
fallback option. So first I tried to install Solus Budgie
on it, thanks primarily to Peter's influence, and it
almost worked. I say almost because once I installed
it, the desktop defaulted to an insanely high
resolution that made everything tiny. So naturally I
went to the Display settings of Budgie and switched
it to a 1920x1080 resolution, one that's worked on it
before. But instead of making the screen look ok, it
made it still small text, but just gave me half a
screen! It was then that I made a "fatal" mistake. I
saw the switch that said something to the effect of
"Use a TV" or something similar. Once I clicked that,
I could barely move my mouse around. So much so
that I had to do a cold boot to exit the system. So,
realizing that I had really goofed up my system, I
tried more than once to reinstall Solus Budgie, but
each time it gave me an error when it attempted to
create the partitions.

So, since I use a Ventoy 32G flash drive for all my
installs of ISO, I rebooted onto it to figure out what
distro to try next on it. As I scanned through my
options, I saw Sparky Gameover edition, so I

decided to install that. However, it had a problem
when it came to creating the partitions as well. It
then dawned on me that I had probably corrupted
the partitions on the drive when I did the cold boot.
So I looked for gparted, or something like it on
Sparky's Live iSO, but I couldn't find anything, not
even Disks. As I scanned down my list of distros on
Ventoy, I said in my head stuff like, "Arch? No, that
would be hard for him to keep updated properly.
Debian? Didn't even boot into the live ISO last time I
tried it. Same for Fedora. Hum? I wonder . . .' as my
eyes fell upon the TBDL version. I had not
downloaded a new ISO that I recall, so after my
previous experiences, I didn't hold out much hope.
But I shrugged my shoulders and decided to give it a
spin. Just to see what would happen. So I booted
into it to be greeted with a more updated grub menu,
even though it was the same ISO that gave me a
more text-based menu before. I almost thought I
should start with the Safe boot, but decided to try the
regular boot first. And to my surprise, at the spot
right before the language selection menu appeared
that it would crash all the time previously, the menu
appeared. I thought, "Hey, this just might work!" And
low and behold, it did boot into the live environment.

So I did find gparted in the menu, and used it to
delete out the partitions. Then, once that had gone
smoothly and I had one big empty disk, I started the
install. I was a little worried about the nVidia GPU,
because I had heard how difficult it is to install the
drivers right. However, I didn't have a single problem
with that aspect of it. After the install, I saw that the
nVidia drivers were installed without so much as me
even telling the installer that I needed them. I was
very impressed! The whole installation process was
as smooth as silk. As a matter of fact, I spent most of
the day looking for the spot where I could change
my display resolutions and make them stick. It
appears that there are three display screens one
can encounter, and only one of them has the box to
click to enable the selected settings to take effect on
startup, as well as today I finally figured out how to
set the display to not disappear after a period of
inactivity. But all that said, the installation for me

Introduction & Testimonial From rlcopple
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went very smooth. Which makes me wonder what
else the installer might work on that previously it
wouldn't. Hum, I wonder . . .

Thanks Alie, and anyone else on his team, assuming
there is a team, for all the work you did in getting this
ready for prime time. I've gone from my initial "I'm
having issues with this distro" all the way to "this is a
great distro!" Screenshot ShowcaseScreenshot Showcase
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Serves 4

Crispy hash browns take center stage in this skillet
breakfast topped with eggs, salsa and plenty of
cheese. Who wouldn’t love this tasty take on a
favorite Mexican breakfast?

Ingredients:

3 tablespoons vegetable oil
1 medium onion, chopped (1 cup)
1 tablespoon chili powder
3/4 teaspoon salt
6 cups frozen shredded hash brown potatoes (from
30-oz bag)
4 eggs
1 cup Thick 'n Chunky salsa (from 16-oz jar)
1 cup shredded Cheddar cheese (4 oz)
Sour cream, sliced avocado, chopped red onion,
cilantro leaves, additional Thick ‘n Chunky salsa, if
desired

Directions:

In a 12-inch nonstick skillet, heat 1 tablespoon of the
oil over medium heat. Add onion; cook 3 to 5
minutes, stirring frequently, until softened. Add chili

powder and 1/2 teaspoon of the salt; cook and stir
for 1 minute.

Add frozen hash brown potatoes and remaining 2
tablespoons oil to skillet; stir to combine. Spread
hash brown mixture evenly in skillet. Cook for 8 to 10
minutes or until the bottom starts to brown. Using

spatula, working in sections, turn hash browns over
so the browned side is on top. Use a large spoon or
spatula to make four indentations in the hash brown
mixture; crack 1 egg into each hole. Sprinkle eggs
with remaining 1/4 teaspoon salt.

Spoon 1 cup salsa around eggs; sprinkle cheese
over salsa. Reduce heat to medium-low; cover and
cook for 10 to 12 minutes or until egg whites and
yolks are firm, not runny and cheese is melted.

Serve with remaining ingredients.

Nutrition:

Calories: 590 Carbs: 70g Fiber: 7g
Sodium: 1220mg Protein: 18g

PCLinuxOS Recipe Corner Bonus

Huevos Rancheros Hash Brown Skillet
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 231, average score 162.

PCLinuxOS Puzzled Partitions
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AMBROSIA APPLE CRISP

BAKLAVA BANANA SPLIT

BISCOTTI BLACK FOREST CAKE

BOMBE BOSTON CREAM PIE

CANNOLI CARAMEL APPLE

CHEESECAKE CHERRY PIE

CHURRO CINNAMON ROLL

COFFEE CAKE CREPE SUZETTE

DOUGHNUT ECLAIR

FLAN FUDGE

HOT FUDGE SUNDAE MACAROON

MOUSSE NEAPOLITAN ICE CREAM

NOUGAT PANNA COTTA

PEANUT BRITTLE POPSICLE

POUND CAKE PRALINE

RICE PUDDING SCONE

SORBET SOUFFLE

SPONGE CAKE SPUMONI

STRUDEL TRIFLE

TRUFFLE ZABIGLIONE
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1. A chewy cookie made with sugar, egg whites, and
almond paste or coconut.

2. An Italian style of ice cream dessert, usually with layers
of different color and flavor.

3. A dessert containing primarily oranges and flaked
coconut.

4. A rolled or folded thin pancake, heated in an orange-
flavored liqueur, and set on fire when served.

5. A foamy, custardlike mixture of egg yolks, sugar, and
Marsala wine, usually served hot or chilled as a dessert.

6. A hard, usually nut-flavored biscuit, derived from the
Tuscan cantucci.

7. An Italian dessert consisting of flavored cream set with
gelatin.

8. A tube of fried pasta, filled with ricotta or similar cream
cheese, and flavorings, eaten as a dessert.

9. A custard that is baked in a caramel-lined mold and
served chilled with the caramel side up.

10. An oblong chocolate covered creme filled pastry.
11. A dessert consisting of a creamy filling usually

containing cheese baked in a pastry or pressed-crumb
shell.

12. A dessert made of paper-thin layers of pastry, chopped
nuts, and honey.

13. An apple that is covered with a candy-like substance
(usually caramel).

14. A Spanish and Mexican pastry resembling a doughnut,
made from deep-fried unsweetened dough and
sprinkled with sugar

15. A round cake that is split and filled with a custard or
cream filling and usually frosted with chocolate.
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Posted by luikki, January 7, 2022, running KDE. Posted by jogurtmen, January 25, 2022, running Mate.

Posted by Meemaw, January 9, 2022, running Xfce. Posted by tbschommer, January 19, 2022, running KDE.
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